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14 Web Browsing

Distrust and caution are the parents of security.

-Benjamin Franklin'

What You Will Learn In This Chapter

Install HTTPS Everywhere

Choose a browser

Enable private browsing

Enable secure web searches

Clear browser history

Install browser plug-ins

Find and remove browser extensions
Detect fraudulent websites

Issues with Adobe Flash and Java
Recover from a web scam

Install Tor for anonymous browsing

Find if you’ve been pwned

! https://en.wikipedia.org/wiki/Benjamin_Franklin
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14 Web Browsing

14.1 HTTPS

Due to an extraordinary marketing campaign, everyone knows the catchphrase:
What happens in Vegas, stays in Vegas. With few exceptions, web surfers think the
same thing about their visits.

Most websites use HTTP? (Hypertext Transport Protocol) to relay information
and requests between user and website and back again. HTTP sends all data in
clear text-anyone snooping on your network connection anywhere between your
computer and the web server can easily see everything that you are doing.

Typically, the only exceptions you will come across are financial and medical sites,
as they are mandated by law to use HTTPS® (Hypertext Transport Protocol
Secure). HTTPS uses the SSL* (Secure Socket Layer) encryption protocol to ensure
that all traffic between the user and server is military-grade encrypted.

e Note: With the recent changes in Google Search Engine Optimization® (SEO)
guidelines that give a higher priority to HTTPS sites, it will soon become
common for sites to use encryption.

Although it is unlikely that you would ever be in the position to enter your
password or bank account into an unsecure web page, you are almost guaranteed
to enter your identity information, such as full name, address, phone number, and
social security number. It is effortless for an identity thief to copy this
information.

Anytime that you visit a web page that is secured using https, it will be reflected in
the URL or address field of your web browser.

In the following example, I visit Wikipedia.org by entering
http://www.wikipedia.org in my browser address field:

[ ] ® (< EH| 2 wikipedia.org

* https://en.wikipedia.org/wiki/Hypertext_Transfer_Protocol
* https://en.wikipedia.org/wiki/HTTPS

* https://en.wikipedia.org/wiki/Transport_Layer_Security

> https://en.wikipedia.org/wiki/Search_engine_optimization
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In the next example, I visit Wikipedia again, but this time I enter
https://www.wikipedia.org in the address field:

[ ] ® < {m B wikipedia.org
m 8 Wikipedia

Note how the address field reflects that I am now connected securely by displaying
https and the Lock icon. Each browser will indicate security slightly differently-
some displaying just the https, some just the lock.

e Note: As of this writing, Wikipedia has implemented automatic forwarding
from HTTP to HTTPS, so if you enter http://wikipedia.org, you are
automatically forwarded to https://wikipedia.org.

Now that I am connected securely to Wikipedia, snoops will not be able to see my
actions. However, they still can see that I am connected to Wikipedia. If you
would like to shield yourself completely, continue reading to our chapter on using
a Virtual Private Network (VPN.)

Having to remember to connect via HTTPS for each web page is an impossible
task. First, you have other, more important items to store in your synapses.
Second, many websites do not have an HTTPS option, resulting in many error
pages and wasted time during the day.

There are two options to resolve this:
e Automate the attempt to connect to sites via HTTPS
e Encrypt your entire online session using VPN

Using VPN is covered in a later chapter. Automating the attempt to connect via
HTTPS is both easy and free. All it requires is a freeware plug-in, HTTPS
Everywhere.

HTTPS Everywhere is available for Firefox, Opera, and Chrome. Unfortunately,
this currently leaves Safari users without the option. If you are happy to use either
of these two browsers instead of Safari, there is no reason not to install HTTPS
Everywhere!
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14.1.1 Assignment: Install HTTPS Everywhere

HTTPS Everywhere is available for Firefox, Opera, and Chrome.

In this assignment, you install HTTPS Everywhere into Firefox.

1.

If the Firefox browser is not currently installed, open Safari, and the go to
http://firefox.com to download Firefox.

Open Firefox.
Select the Tools menu > Add-ons.

Select Get Add-ons from the sidebar, scroll to the bottom of the page, and then
select the See more add-ons! button.

S ¢ @ © Firefox | about:addons w m o e & =
Translate easily with To Google Translate by Juan Escob 4 h

:<> Get Add-ons 2 ran y»w QA oogle Translate A.Jar‘ scobar )
Highlight any text, right-click, and translate instantly.

*. Extensions
L7 Themes

i Plugins

Dreams Beach by candelora e

Hover over the image to preview

Privacy Policy

In the Search field, enter https everywhere, and then press the Return key.
Matching items will appear below.
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Developer Hub | Registeror Login

> -
~—) Firefox Add-ons Explore  Extensions Themes More... v

Featured Extension ®
472,976 569 Thhk
Users Ratings Overall
Rating

HTTPS Everywhere
by EFF Technologists

Encrypt the web! HTTPS Everywhere is a Firefox

extension to protect your communications by
enabling HTTPS encryption automatically on sites + Add to Firefox
that are known to support it, even when you type

URLs or follow links that omit the https: prefix.

6. Select the Add to Firefox. HT'TPS Everywhere will download.

7. Atthe Add HTTPS Everywhere? confirmation window, select the Add button,
and then the OK button.

8. HTTPS Everywhere is now installed in Firefox.

You can repeat this process for Chrome and Opera.
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14.2 Choose a Browser

There many web browsers available on the market, with each placing a different
emphasis on various features. The most popular browsers for macOS are Safari,
Mozilla Firefox, and Google Chrome. Safari is included with macOS, while
Chrome and Firefox are available as free downloads. Why might you want to
replace Safari with another browser? Chrome integrates tightly with Google’s own
services, offering features such as direct voice translation and an ultra-
minimalistic interface. Firefox touts itself as the most privacy-respecting browsers,
and while that is a subjective claim, Firefox does not transmit your data to Google
or any other 3™ party company every time you search using the address bar box.
While Google considers this “non-identifying information”, IP addresses are
identifying at the Internet Service Provider level. This functionality can be
changed, and with some tweaking, it is possible to make Chrome more privacy
focused.

Browser Platform Price Notable Features Privacy
Chrome Android, iOS, Free Speed Fair
Llpux, macOs, Google Services
Windows .
Integration
History and Bookmarks
can be shared between
your devices running
Chrome
Edge Windows 10 Free (included Active X Fair
Vlv(;;h Windows Windows Integration
Firefox Android, iOS, Free (Open Add-ons Good
Linux, macOS, Source) Privac
Windows Y
History and Bookmarks
can be shared between
your devices running
Firefox
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Safari

macQOS, iOS

Free (included
with macOS/OS
X and iOS)

History and Bookmarks
can be shared between
all your macOS and iOS
devices

Good
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14.3 Private Browsing

Private Mode (Safari), Private Browsing (Firefox), and Incognito Mode (Chrome),
are features that prevent any normally cached data from being written to storage
while using a browser. This data includes browsing history, passwords, user
names, list of downloads, cookies, and cached files. This is an essential tool if you
work on a computer where your account is shared (what’s with that?.), or if there
is the possibility that someone else will examine your browsing habits. This does
not prevent your company IT department or Internet Provider from seeing or
recording your browsing habits.

14.3.1 Assignment: Safari Private Browsing

Before we secure your website travels from roaming eyes out on the Internet, we
should first be secure from the roaming eyes on the home front. If you have
secured your computer to this point, including: Strong password, nobody else has
access to your account, your System Preferences > Security & Privacy are set to
Require password after sleep or screen saver begins, it is unlikely that you also need
to implement Safari Private Browsing. But just in case...

In this assignment, you enable Private Browsing within Safari
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1. From the Safari File menu, select New Private Window.

& Safari

File

Edit View History Bookmarks

New Window 38N
New Private Window {+3N
New Tab ®T

Open File... #0
Open Location... £

Close Window W
Close All Windows X {3W
Close Tab #’W
Share >

Open in Dashboard...

Import From >
Export Bookmarks...
Print... #8P

Window Help

2. A new Safari window will appear. You can see that you are in Private Browsing
by the Search field being dark.

[ JON il]

8 bearch or enter website name

Private Browsing Enabled

Favorites

Safari will keep your browsing history private for all tabs in this window. After you close this window, Safari won't remember th...

-

° i
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Sites that are visited from within this window will leave no trace in the History,
and cookies are not shared with any other browsing windows.

14.3.2 Assignment: Firefox Private Browsing

If you prefer Firefox to Safari, then let us enable its private browsing.
1. Launch Firefox.

2. Select the Firefox File menu > New Private Window.

@ Firefox Edit View History Bookmarks Tools Window Help

New Tab ®T
New Window 8N
New Private Window {*3P
Open File... #0
Close Tab #BW
Close Window TEW
Save Page As... #S
Email Link...

Page Setup...

Print... #8P
Work Offline
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3. A new Private Window opens, informing that you are now, well, browsing
privately.

e Note: A Firefox Private Window will display a mask icon in the left side of
a private tab, and in the top right corner of a private window.

Private Browsing with Tracking Protection

When you browse in a Private Window, Firefox does not save:

 visited pages * cookies
e searches e temporary files

Firefox will save your:
e bookmarks * downloads

Private Browsing doesn’t make you anonymous on the Internet. Your employer or Internet service
provider can still know what page you visit.

Tracking Protection (Sl

Some websites use trackers that can monitor your activity across the Internet. With Tracking
Protection Firefox will block many trackers that can collect information about your browsing
behavior.

Learn more about

14.3.3 Assignment: Google Chrome Incognito Mode

If your preference leans toward Google Chrome, you can enable its Incognito
Mode.

1. Launch Google Chrome.

2. Select the File menu > New Incognito Window.
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@ Chrome Edit View History Bookmarks People Window Help
New Tab ®BT

New Window 3#EN

Reopen Closed Tab 08T
Open File... #0
Open Location... 8L
Close Window T 8W
Close Tab #W
Save Page As... 3#S
Email Page Location 88l

Print... 3P

3. A new Incognito Window opens, informing that you have now, gone
incognito.

e Note: A Chrome Incognito Window will display the incognito icon in the
top right corner, and the title bar will turn dark.

You've gone incognito

Now you can browse privately, and other people who use this device won't see your

activity. However, downloads and bookma vill b

Chrome won't save the following information

» Yourk ry

» Cooki data

« Information entered in forms « Your internet service provider
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14.4 Secure Web Searches

With most web browsers, when performing a search, the search criteria and sites
visited are collected and stored by the search engine. The Cookies assigned from
one website can communicate with other sites and webpages you open. Also, most
search engines record your searches and build a profile of your search history so
that your search results will be unique and tailored to your interests.

Not so with the DuckDuckGo search engine. DuckDuckGo’s policy is that it keeps
no information on user searches, nor does it track search queries via IP addresses.
Subsequently, all search results are identical for everyone.

Starting with OS X 10.10, Safari offers the option to make DuckDuckGo your
default search engine. This is a big step towards providing a better level of privacy
on the Web.

14.4.1 Assignment: Make DuckDuckGo Your Safari Search Engine

In this assignment, you change the default Safari search engine from Google to the
secure search engine DuckDuckGo.

1. Open Safari.
2. Open the Safari menu > Preferences.
3. Select the Search icon from the Toolbar.

4. From the Search Engine pop-up menu, select DuckDuckGo.

o Search

=L ¢ Qe O @ B O

General Tabs AutoFill Passwords Search Security Privacy Websites Extensions Advanced

Search engine: = DuckDuckGo u

Include search engine suggestions

Smart Search Field: Include Safari Suggestions
Enable Quick Website Search Manage Websites...
Preload Top Hit in the background
Show Favorites ?
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5. Close the Preferences window.

From now on, your default search engine for Safari will be DuckDuckGo, hiding
your search activities.

14.4.2 Assignment: Make DuckDuckGo Your Firefox Search Engine

In this assignment, you change the default Firefox search engine to the secure
DuckDuckGo.

1. Open Firefox.
2. Select the Firefox menu > Preferences.

3. Select Search from the sidebar, and then select DuckDuckGo from the Default
Search Engine pop-up menu.

It General Search

Q_ search Search Bar

“ Privacy & Security ® Use the address bar for search and navigation
/<)

& Firefox Account
Add search bar in toolbar

Default Search Engine

Choose the default search engine to use in the address bar and search bar.

@ DuckDuckGo -

v Provide search suggestions

v Show search suggestions in address bar results

4. Close the Preferences window.

From now on, your default search engine for Firefox will be DuckDuckGo, hiding
your search activities.
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14.4.3 Assignment: Make DuckDuckGo Your Chrome Search Engine

In this assignment, you change the default Chrome search engine to

DuckDuckGo.
1. Open Chrome.
2. Go to https://duckduckgo.com.

3. On the DuckDuckGo home page, select Add DuckDuckGo to Chrome.

DuckDuckGo

Switch to DuckDuckGo and
take back your privacy!

1 We don't store your personal info.

3 We don't track you. Ever.

Add DuckDuckGo to Chrome

Il

2 We don't follow you around with ads.

4. Atthe Add DuckDuckGo for Chrome? Window, select Add Extension.

Add "DuckDuckGo for Chrome"?
*hhxn (224)

601,838 users
Open in Web Store

It can:
. Read and change your data on all duckduckgo.com sites and
duckduckgo.com
= Change your search settings to: duckduckgo.com

Cancel Add extension
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5. To verify DuckDuckGo is the new default search engine, perform a search in
Chrome. Note the Duck logo.

@ Marc L. Mintz Q

Web Images Videos Products

All Regions ~ Safe Search: Strict v Any Time ~ Send feedback

Marc Mintz's History - Marc Mintz's Past Available Online.
Marc Mintz's Past Available Online. Simply Search a Name and State.
RecordsTruthFindercom @ Report Ad

Marc L. Mintz - Mintz IT
Marc L. Mintz - Mintz IT | Virtual CIO , IT Consulting, and Computer Support

il https:/mintzit.com/marc--mintz/

From now on, your default search engine for Chrome will be DuckDuckGo, hiding
your search activities.
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14.5 Clear History

By default, every browser maintains a full history of every site you have visited.
Should someone gain access to your device, they will be able to view your
browsing history.

You just realized that: 1) Your mother is coming over, 2) you have been naughty
on the web all day, 3) you did not turn on Private Browsing, and 4) your mom will
teel insulted if you insist that an account for her must to be created instead of
accepting her protest: Oh, baby, I only need to check my AOL email. Just let me get
on your account for a minute.

Is it time to panic?

Not yet! You can erase your entire (steamy) browsing history in one click.

14.5.1 Assignment: Clear the Safari History

In this assignment, you clear your entire browsing history in Safari.

e Note: Be forewarned, there is no recovery from this action. If you wish to keep
your history, pass on this assignment.

1. Open Safari, and then select the History menu > Clear History...

@ Safari File Edit View Bookmarks Window Help

Show All History ®Y
Home 0 38H
Clear History...
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2. A dialog box opens asking for what time frame you wish to clear your history.
Make your selection, and then select the Clear History button.

Clearing history will remove related cookies
and rihas senbaiia dasa
the last hour

Histo r devices signed into
today ! 9

today and yesterday
Clea v all history

your |

? Cancel Clear History

The Safari history is now cleared as you defined.

14.5.2 Assignment: Clear the Firefox Browsing History

In this assignment, you clear your Firefox browsing history.

Note: Be forewarned, there is no recovery from this action. If you wish to keep
your history, pass on this assignment.

1. Open Firefox.

2. Select the History menu > Clear Recent History... The Clear All History
window opens.

@ Clear Recent History

Time range to clear: = Last Hour

v | Details

LU Clear Now |
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3. Select the Details disclosure button to expand your options.

(@] Clear Recent History
Time range to clear: = Last Hour B

~ | Details

Browsing & Download History
Form & Search History
Cookies
Cache
Active Logins

Offline Website Data

Site Preferences

SR Clear Now |

4. Select the Time range to clear, which history items are to be cleared, and then
click the Clear Now.

5. Close the Clear Recent History window.

The Firefox history is now history.

14.5.3 Assignment: Clear the Chrome History

In this assignment, you clear your browsing history in Chrome.

e Note: Be forewarned, there is no recovery from this action. If you wish to keep
your history, pass on this assignment.

1. Open Chrome.
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2. Select the Chrome menu > Clear Browsing Data

window opens.

... The Clear Browsing Data

Clear browsing data

Clear the following items from

(< I < I < I <

O 0 O O

the past hour
Browsing history
4 items

Download history
None

Cached images and files
Less than 2.6 MB

Cookies and other site data
This will sign you out of most websites.

Passwords
None

Autofill form data
None

Hosted app data
5 apps (Cloud Print, Gmail, and 3 more)

Media licenses

You may lose access to protected content from some sites

CANCEL CLEAR BROWSING DATA

© Some settings that may reflect browsing habits will not be cleared. Learn

more

3. Select which items are to be cleared, and then click the Clear Browsing data

button.

Done!
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14.6 Browser Plug-ins

One of the great advances in personal computer software development was the
concept of plug-ins or extensions®. These small strings of code add functionality to
the host application. In the case of web browsers, this may be anything from the
ability to encrypt web-based email, to viewing proprietary video formats.

The bad news about plug-ins is that they run with the full power of the host
application. This means that a malicious plug-in may have the power to secretly
redirect your web browser to fake websites (such as a phony copy of your bank),
or harvest all your passwords, monitor your purchases, etc.

There are many malicious plug-ins. It is vital to only install those plug-ins that
you need to install, to know which plug-ins are installed, and to rid yourself of
unnecessary plug-ins.

14.6.1 Assignment: Install TrafficLight Plug-In For Safari

In this assignment, you search for extensions for Safari, and then install the
TrafficLight anti-malicious website extension.

e Note: Prior to macOS 10.13, Safari Extensions were found in a separate area of
the Apple website. Starting with macOS 10.13, Safari Extensions are moving to
the Mac App Store. As of this writing, Apple was in transition with how to
acquire and install Safari Extensions, with almost all Safari Extensions still
found on the Apple site, and none on the Mac App Store.

1. Open Safari.

¢ https://en.wikipedia.org/wiki/Plug-in_(computing)
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2. Select the Safari menu > Safari Extensions... The Safari Extensions page opens.
Scroll down to see the featured Extensions located on the Apple Safari
Extensions site. You may also search for Extensions in this area.

3. Assuming Apple will quickly migrate Extensions to the Mac App Store, Select
Go to the Mac App Store.

Safari Extensions

Discover powerful Safari Extensions
now available in the Mac App Store.

Go to the Mac App Store 2
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4. The Mac App Store opens to Safari Extensions. Select the Popular, Recent, or
Categories links to explore the available Safari Extensions.

*

4]

Q search

Featured Top Charts  Categories  Purchased Updates
S f . E t .
Customize your browsing experience.
Safari Extensions sortBy: Featured
inPicture - Watch Vide.. Kaspersky Password M... Furiganify! PiPifier - PiP for nearly .
Video Productivity Utilities Utilities
Kk kA a3 Ratings

15099 v | GET v (oET]v) (oET]v)

@ e

Voice Reader for Safari
Utilities

Translator for Safari
Productivity

CPhpoO o

Translator for Internet ..

Productivity

In-App Purchases

Bookmarx - Shuffle yo...

Productivity

Translator & Voice Coll...

Productivity

PO

OverPicture for Safari
Utilities

Wotja: Lyric Generator
Productivity

In-App Purchases

Password Manager by
Utilities

Color Calculator + Wid.
Business

In-App Purchases

Read One
Productivity

SmileAllDay

Lifestyle

TubeBuddy for YouTube
Social Networking

5. Explore and review some of the available extensions.
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In the Search field, enter TrafficLight, and then tap the Return key. The
TrafficLight from Bitdefender page opens. TrafficLight is a browser extension
that adds protection from malicious websites. If you happen upon a
compromised or malicious site, it will alert you and provide a button to back
out of the site before your system is penetrated.

® < in] 82 s % @ Apple Inc ¢ o N a

Apple - Safari - Safari Extensions Gallery aF

1 result found for 'trafficlight'

TrafficLight

Security
Bitdefender SRL »

Taking the security-while-browsing
concept where it belongs: in the
browser. This extension will add a strong
layer of security over your browsing
experience without inducing speed
penalties or system resource
consumption.

Install now @®

7. Select the Install now link located under the description of TrafficLight.

8. When installation completes, you will see a traffic light icon in your Safari tool

bar.

g

14.6.2 Assignment: Install TrafficLight Plug-In For Google Chrome

In this assignment, you search for extensions for Chrome, and install the
TrafficLight anti-malicious website extension.
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1. Open Google Chrome.

2. Select the Menu icon (3 lines at the right edge of the tool bar) > More Tools >
Extensions. Any currently installed extensions will display.

Extensions "] Developer mode

o DuckDuckGo for Chrome  42.8.12
DuckDuckGo enhancements for Chrome.

Permissions Options Details

LY

| Enabled \mf

| Allow in incognito

E Google Docs 0.9
Create and edit documents

Permissions Details

LY

| Enabled o]

| Allow in incognito

g* Google Docs Offline 1.4 < Enabled o
" Get things done offline with the Google Docs family of products.

Permissions Details

| Allow in incognito

. Google Sheets 1.1
2] Create and edit spreadsheets

Permissions Details

<

| Enabled ]

Allow in incognito

LY

w Google Slides 0.9 | Enabled o]

Create and edit presentations

Permissions Details

| Allow in incognito

a Get more extensions Keyboard shortcuts

3. Scroll to the bottom of the page, and then select Get More Extensions.

4. Explore the available extensions.
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5. Inthe sidebar, select Extensions, in the Search the store field, enter TrafficLight,
and then tap the Return or Enter key. The results page appears.
g~ chrome web store Signin | %
| o x| R o [+ ooroomoe
trafficlight @ ﬂ o;gre;cb;ﬁa:ficligh(.bl(defender.com bdelatli Mty
SIS L 2 TRl Bitdefender TrafficLight adds a strong and non-intrusive Kk kdd (695)
sy LS layer of security to your browsing experience.
© Extensions Clear
Aeps bEDCREER Social & Communication
l Place a trafficlight on every page you want. Made for use in *hkk (3
6. Inthe TrafficLight offered by trafficlight Bitdefender area, select the Add To
Chrome button. If prompted to confirm, confirm the addition.
7. Atthe Add TrafficLight? Window, select Add extension.
8. Once installed, you will see the TrafficLight icon in the Chrome tool bar-a
green dot.
14.6.3 Assignment: Install TrafficLight For Firefox

In this assignment, you search for plug-ins for Firefox, and install the TrafficLight
anti-malicious website extension.

1.
2.
3.

Open Firefox.
Select the Menu menu (3 lines at the right edge of the tool bar) > Add-ons.
Select Get Add-ons from the left sidebar.

Explore the available add-ons.
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5. Inthe Search all add-ons field, enter TrafficLight, and then tap the Return key.
The results page appears.

® ® F°3 Add-ons Manager x ‘\+
€  )Fireiox  about:addons ¢ #*|v Q search w B 4 A de. ) =

(&) Most Visited ~ ¢ Getting Started (] From Safari ~

Some extensions could not be verified f o 34 TrafﬁcLight[ l
Q Search
@ Cet Add-ons Name Last Updated Bestmatch v
o Extensions Search: My Add-ons (@ Available Add-ons
® Appearance :g; Bitdefender TrafficLight for Firefox dpdi16,2015 —
Bitdefender TrafficLight adds a strong and non-intrusive layer of security to your browsing experi... More

Plugins

& Services

6. In the Bitdefender TrafficLight for Firefox area, select the Install button.
7. At the confirmation window, confirm OK.

8. Once installed, select the Restart now link.

® ® w Add-ons Manager x \+

€ | ) rielox about:addons ¢ #|r Q search w e 3+ A0 @ =
(&] Most Visited ~ ¢ Getting Started (L] From Safari ~

Some extensions could not be verified Q v TrafficLight
Q Search
@ CetAdd-ons Name Last Updated Bestmatch v
W Extensions Search: My Add-ons (@) Available Add-ons
Gg Appearance +/ TrafficLight will be installed after you restart Firefox. Restart now Undo

g TrafficLight February 22, 2016
Plugins RS  itdefender TrafficLight adds a strong and non-intrusive layer of security to your browsing experience ~ More

¢ Services

9. Once installed, you will see the TrafficLight icon in the Chrome tool bar-a

green dot.
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14.6.4 Assignment: Find and Remove Extensions From Safari

In this assignment, you see the installed Safari Extensions, determine if they are
what you need, and remove those that are not needed.

1. Open Safari.
2. Select the Safari menu > Preferences.

3. From the Preferences tool bar, select Extensions.

5=/ ¥ Qa0 @ & O

i S —
v [Welll TrafficLight = TrafficLight 0.2.25
:g: TrafficLight adds a strong and non-intrusive layer of security to your

browsing experience

Uninstall

“TrafficLight” can read, modify, and transmit content from all webpages. This could
include sensitive information like passwords, phone numbers, and credit cards.

v Automatically update extensions from the Safari Extensions Gallery More Extensions... ?

4. All currently installed Extensions will display in the sidebar.

5. If you see any Extensions that you do not remember installing, perform an
Internet search to discover what they do, and if they present a vulnerability.

6. Ifyou determine you don’t want any Extensions installed, select the target
Extension in the sidebar, and then select the Uninstall button under the target
extension.
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14.6.5 Assignment: Find and Remove Extensions from Chrome

In this assignment, you see the installed Chrome Extensions, determine if they are
what you need, and remove those that are not needed.

1. Open Chrome.
2. Select the Menu menu (3 lines at the right edge of the tool bar) > Settings.

3. Select Extensions from the left sidebar. The Chrome Extensions page opens.

® ® 4 Extensions 3 Marc

& C n chrome://extensions PRy QI oﬂ a ! ) \EJ Q BN @ ° ne=

ii* Apps [ SalesForce Syncto [ Favorites () LogMeln Central (L] USB Biz Cards [.] $88 (L. udemy » ] Other Bookmarks
Chrome Extensions

Developer mode

History

I Extonsions Adobe Acrobat  15.1.0.1 @ Enabled B

Convert current web page to an Adobe PDF file

Permissions Options Details

| Allow in incognito

Warning: Google Chrome cannot prevent extensions from recording your browsing
history. To disable this extension in incognito mode, unselect this option.

Application Launcher for Drive (by Google) 3.2 «! Enabled |}
Open Drive files directly from your browser in compatible applications installed on your
computer.

Permissions  Details

) Allow in incognito

Warning: Google Chrome cannot prevent extensions from recording your browsing history.
To disable this extension in incognito mode, unselect this option.

Chrome Remote Desktop ~ 49.0.2623.40 ¥ Enabled ::5)

p]

Access other computers or allow another user to access your computer securely over
the Internet.

Permissions  Details

Allow in incognito Allow access to file URLs

4. If you see any Extensions that you do not remember installing, perform an
Internet search to discover what they do, and if they present a vulnerability.

5. If you determine you don’t want any Extensions installed, click the Trash icon
to the far right.
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In this assignment, you see the installed Firefox Extensions, determine if they are

14 Web Browsing

what you need to be installed, and remove those that are not needed.

1. Open Firefox.

2. Select the Menu menu (3 lines at the right edge of the tool bar) > Add-ons.

3. Select Extensions from the left sidebar.

.H Get Add-ons

o Extensions
’@ Appearance

* Plugins

° Services

6. If you see any Extensions that you do not remember installing, perform an
Internet search to discover what they do, and if they present a vulnerability.

7. Ifyou determine you don’t want any Extensions installed, click the Remove

button

® L] Q Moxzilla Firefox Start Page x Q Preferences x Fod Add-ons Manager
€ ) O Firefox  about:addons ¢ #|r Q search
(3] Most Visited ~ Getting Started (L] From Safari ~
Some extensions could not be verified ﬂ ¥

Flash Video Downloader - YouTube HD Downl...

Flash Video Downloader helps you to download any video (flv,... More

HTTPS-Everywhere

Encrypt the Web! Automatically use HTTPS security on many ... More

Invite All (for Facebook)
Invite all your Facebook friends to an event with one click! More

Shodan Firefox Addon

Coming soon... More

TrafficLight

Bitdefender TrafficLight adds a strong and non-intrusive layer of security to your ...

x ek

Search all add-ons

Preferences

Preferences

More

Disable

Disable

Disable

Disable

Disable

"B O ¥ AOD O 4 D

Remove

Remove

Remove

Remove

Remove

to the far right.
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8. Select Plugins from the left sidebar.

oo @  MozllaFiefoxStartPage % | %% Preferences x [ # Add-ons Manager x \ +

€ ) ©Fiefox about:addons ¢ ¥ |v Q search "B O3 AO @ 4D =

(&] Most Visited ~ ' Getting Started (-] From Safari ~

o 34 Search all add-ons
@ Cet Add-ons

- Check to see if your plugins are up to date
" Extensions

Microsoft Lync Web App Plug-in

Microsoft Lync Web App Plug-in ~ More

Always Activate v

60 Appearance

‘ “* Plugins

| OpenH264 Video Codec provided by Cisco Syste... P— oo
. This plugin is automatically installed by Mozilla to comply with the We... More
& Services
Shockwave Flash

Always Activate S 4
Shockwave Flash20.0r0  More

WebEx64 General Plugin Container

WebEx64 General Plugin Container Version 205 More

Always Activate v

Adobe Acrobat NPAPI Plug-in, Version 15.010.20059

Ask to Activate Y

9. Perform an Internet search on any plugins that are unfamiliar to you. If you
determine you don’t want one active, select Never Activate from the pop-up
menu to the far right.
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14.7 Fraudulent Websites

As of this writing, there are over 1,000,000,000 active websites’. Within that, there
may be millions of fraudulent websites. Of the diverse types of fraud found on the
Internet®, among the most common are websites that misrepresent who they are.
This may be in the form of appearing like Bank of America, but with a URL of
perhaps http://bankofamerica.cm, instead of the true http://bankofamerica.com.
In this case, the criminal is hoping for someone to make the typo. Once at their
site, you would enter your account and password as typical. The difference is that
this time, the criminal now has your credentials—and all your money within
minutes.

As a side note, in this specific example as of the time of this writing, this URL
actually is as scam site. But not for the scheme mentioned. When I went to
http://bankofamerica.cm, I was routed to the following:

000 < M ] § o apple.com-----systemmessenger.com < (4] [ml

VIRUS FOUND +

VIRUS FOUND

A website you visited today has infected your Mac with a virus.

Press OK to begin the repair process.

If we look at the full URL, it is: http://apple.com-----
systemmessenger.com/dgkg/?city=Albuquerque&region=New%20Mexico&count
ry=US&ip=71.222.135.33&isp=Qwest%20Communications%20Company%20Llc
&05=05%20X&0sv=085%20X%2010.11%20E1%20Capitan&browser=Safari&brow
serversion=Safari%209&voluumdata=BASE64dmlkLi4wMDAwMDAwNi01Yzg0
LTRjNjYtODAwWMCOWMDAWMDAwWMDAwWMDB{X3ZwaWQuLmRI...

7 http://www.internetlivestats.com/total-number-of-websites/
8 https://en.wikipedia.org/wiki/Internet_fraud
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From this URL, we can see that the criminal site attempts to appear as though it is
Apple reporting that I have a virus.

They have also discerned my city, state, IP address, Internet provider (Qwest
Communications), that I am using OS X 10.11 El Capitan, with Safari version 9.

If I were the typical user, I'd probably think there was a virus present and press the
OK button as recommended. You may have also noticed the criminal was bright
enough to do all of this, but not bright enough to put an OK button in the script!

So, I press the Close button. I'm presented with a new window:

@ ® <« (im} ] apple.com----- systemmessenger.com (5 (4] th o »
(A} VIRUS FOUND F
VIRUS FOUND

A website you have visited today has infected your Mac with a virus. A full system
U scan is now required to find and remove harmful files or applications from your OS X
device.

DEVICE INFORMATION

= Brand: Apple

= Device: Mac, OS X 10.11 El Capitan

= Browser: Safari 9

= IP: 71.222.135.141

= Provider: Qwest Communications Company Llc (ISP)

= Location: New Mexico - US

Scan Now
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Hey, who needs an OK button when the Close button will do the intended scam!
So, let’s see what happens when clicking the Scan Now button:

[ ) ® < (Im} 5 apple.com----- systemmessenger.com (4] th a »

(A} VIRUS FOUND aF

&) DOWNLOAD REQUIRED

Please download the MacCleaner application to remove Bankworm from your Mac.

VIRUS INFORMATION

X Virus Name: Bankworm
X Risk: HIGH

X Infected File: /os/apps/worm.icv

VIRUS REMOVAL

+ Application: MacCleaner
v Rating: 9.9/10

v Price: Free

REMOVE VIRUS NOW

Appears they think I am infected with the Bankworm virus (which may or may
not be a real malware name), and the infected file is in /os/apps/worm.icv. The
only real problem I see is that there is no such file, and no such directory.
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But they are offering a free solution to my non-existent problem. Let’s see where
that takes us by clicking the Remove Virus Now button:

0O < 5] L] mackeeperapp.mackeeper.com ¢ (4]

Q

»

E MacKeeper Lt
@ MacKeeper

Human inside

Thank you for downloading MacKeeper!

System Requirements: Mac OS X 10.6 or later

MacKeeper is a bundle of 16 tools for your Mac cleaning, optimization with online and offline security block.
You will download the installation file compatible with your browser.

Your download of MacKeeper will start automatically. If it doesn't happen, CLICK HERE

Follow two easy steps to Drag the MacKeeper icq

1 » Download MacKeeper to your Mac. 2 » install MacKeeper. 3 » Applications folder to yd

MacKeeper?! Really! This product lost a class action lawsuit for deceptively
advertising its functionality®.

If you have followed along so far, just trash the MacKeeper download.

So, how to protect yourself against fraudulent sites? We will go through the few
steps that can be taken, but the most important tool is your awareness.

* https://topclassactions.com/lawsuit-settlements/closed-settlements/94767-
mackeeper-class-action-settlement/
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14.8 Do Not Track

Most websites track which pages you visit, how long you stay on each page, and
other metrics to better understand their visitors. That is a little creepy. Imagine
going to the library, and having a librarian looking over your shoulder as you scan
the card catalogue, and records each of the books and pages you glanced at.

Now let’s take the analogy further. You leave the library and go across town to
have lunch, and then shop for shoes. You look around and the same librarian is
still watching and recording not only everything you have eaten, but everything
you looked at on the menu.

Later you go for a date, and the librarian is sitting right behind you in the theater,
noting who you are with, what scenes you reacted to, and more.

Web browsing isn’t much different-except the snoop is normally invisible in the
form of cookies.

Any website can initiate cookies on your browser. These keep a record of the
pages you visit on the site. But they have evolved to report all the other places you
visit and things that you do. This is why you can visit Amazon, look up my books,
quit the web browser, launch it, go to okcupid, and see an ad for my books!

No, I'm not doing it, Amazon is. They know that you were interested in my book,
and will prod you with images of it for a few days, assuming you will eventually
succumb and buy.

There is the option to disable cookies, but most of your websites will demand they
be enabled to visit the site.

Although there is no 100% solution to this intrusion, you can configure your
browser to ask websites to not track your activities. And if you believe that works,
I've got a bridge to sell you.
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Ghostery

We can take Do Not Track to another level. To do this, we need to install a
browser extension called Ghostery. Ghostery will display every tracker attempting
to monitor your web activities, and gives you the ability to block them from
garnering that information.

14.8.1 Assignment: Secure Safari

In this assignment, you secure Safari.
1. Open Safari, click the Safari menu > Preferences > Security.

2. Enable Warn when visiting a fraudulent website.

[ ] Security

8L § Qe 0@ & O

General Tabs AutoFill Passwords Search Security Privacy Websites Extensions Advanced

Fraudulent sites: Warn when visiting a fraudulent website

Safari uses Google Safe Browsing to identify
fraudulent websites.

Web content: Enable JavaScript
Block pop-up windows

3. Select the Privacy tab.

o Privacy

v A= 00 & O

General Tabs AutoFill Passwords Search Security Privacy Websites Extensions Advanced

Website tracking: Prevent cross-site tracking
Ask websites not to track me

Cookies and website data: Block all cookies

Manage Website Data... ?

4. Enable Website tracking: Prevent cross-site tracking
5. Enable Website tracking: Ask websites not to track me.

6. Close Safari Preferences.
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14.8.2 Assignment: Secure Firefox

In this assignment, you secure Firefox.

1. Open Firefox, click the Firefox menu (three horizontal lines), and then select
the Preferences button.

2. Inthe Preferences page, select General from the sidebar, and then scroll down
to Firefox Updates. Set to Automatically install updates.

¥ General Firefox Updates
Q_ search

n Privacy & Security Version 59.0.2 (64-bit) What's new Show Update History...

Keep Firefox up to date for the best performance, stability, and security.

A Lietox A . +» Firefox is up to date Check for updates
&~ Firefox Accoun

Allow Firefox to

® Automatically install updates (recommended)
Check for updates but let you choose to install them
Never check for updates (not recommended)

v Automatically update search engines

3. Inthe Preferences window, select on Privacy & Security in the left-hand pane,
scroll down to History, and then select Firefox will Use custom settings for
history. Configure to your taste, and here are my recommendations:

-ﬁ- General History
Q search Firefox will Use custom settings for history ~ ~
a Privacy & Security Always use private browsing mode

= v Remember my browsing and download history
r Firefox Account

v Remember search and form history

v Accept cookies from websites Exceptions...
Accept third-party cookies = From visited -
Keep until | close Firefox v Show Cookies...

Clear history when Firefox closes Settings...
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Scroll down to the Tracking Protection area, enable Use Tracking Protection to
block known trackers Always.

Set Send websites a “Do Not Track” signal that you don’t want to be tracked to
Always.

2 Find in Preferences

¥ General Tracking Protection

Q Search Tracking Protection blocks online trackers that collect your browsing data across multiple
websites. Learn more about Tracking Protection and your privacy

ﬂ Privacy & Security Use Tracking Protection to block known trackers

Exceptions...

® Always
g Firefox Account Y

Change Block List...
Only in private windows

Never

Send websites a “Do Not Track” signal that you don’t want to be tracked Learn more

Only when using Tracking Protection

® Always

6. Scroll down to Permissions. For Location, Camera, Microphone, and

Notifications, select the Settings button. If there are sites listed to have access
these services, remove them as desired.

% General Permissions
Q search ~ Location Settings...
& Privacy & Security K Camera Settings...
§ Microphone Settings...
s Firefox Account =
@ Notifications Learn more Settings...
v Block pop-up windows Exceptions...
v Warn you when websites try to install add-ons Exceptions...
Prevent accessibility services from accessing your browser Learn more
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7. Enable Block pop-up windows to prevent them.

8. Enable Warn you when websites try to install add-ons.

9. Scroll down to Security. Enable Block dangerous and deceptive content.
10. Enable Block dangerous downloads.

11. Enable Warn you about unwanted and uncommon software.

12. Close Firefox Preferences.

Congratulations. Your Firefox Browser is now secured from phishing attacks,
third-party advertisers and known malware sites.

14.8.3 Assignment: Secure Chrome

Just as with Firefox, there are settings within Chrome that will keep you properly
secured against the bad guys.
In this assignment, you secure Chrome

1. Open Chrome, select the menu item (3 dots), and then click Settings.

2. Click the 3 horizontal lines at the top left, select Advanced, and then select
Privacy & Security. Recommended privacy and security settings are shown
below:
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= Settings

Privacy and security

Google Chrome may use web services to improve your browsing experience. You may optionally disable these
services. Learn more

Use a web service to help resolve navigation errors

Use a prediction service to help complete searches and URLs typed in the address bar

Use a prediction service to load pages more quickly

Automatically send some system information and page content to Google to help detect dangerous
apps and sites

Protect you and your device from dangerous sites

Automatically send usage statistics and crash reports to Google
Send a "Do Not Track" request with your browsing traffic .

Use a web service to help resolve spelling errors
Smarter spell-checking by sending what you type in the browser to Google

Manage certificates
Manage HTTPS/SSL certificates and settings

Content settings
Control what information websites can use and what content they can show you

Clear browsing data
Clear history, cookies, cache, and more

3. While you are here, have a look around and configure the rest of the Privacy &
Security area.

Congratulations. Your Chrome Browser is now securing from phishing attacks,
third-party advertisers and known malware sites.
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14.8.4 Assignment: Install Ghostery for Safari

In this assignment, you install the Ghostery extension for Safari, monitor who is
monitoring you, and then block them.

1. Open Safari.

2. Browse to https://ghostery.com.

3. Select the Install Ghostery button. A link will download.

4

In your Downloads folder, locate and then double-click the
Ghostery.safariextz.

5. Inthe Ghostery is from the Safari Extension Gallery window, select Visit
Gallery.

6. Inthe Safari Extensions web page, select Install now.

7. The Ghostery Introduction page will open. Read the information, and then
click the Next buttons.
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8. Atthe Notification page, enable Click here to enable Alert Bubble. This will
briefly display the trackers at each page visited. Then select Next.

9. Atthe Blocking page, select which trackers you want blocked, and then select
the Next button. My recommended settings are shown below:

Blocking

Ghostery can prevent the page elements it detects from running in your browser.

Blocking trackers will prevent them from running in your browser, which can help control how your behavioral data is tracked. Keep in mind that
some trackers are potentially useful, such as social network feed widgets or browser-based games ... Blocking may have an unintended effect
on the sites you visit.

Please let us know if you run into any issues.

Trackers that got blocked will be crossed out in the alert bubble and the findings panel.

Blocking 1761 out of 2080 trackers.

Show
When you block a tracker, that tracker is prevented from
communicating with its third-party provider. Search for tracker name

ABTesting 9  Affiliate Marketing 47  Analytics 116  Audio/ Music Player 4  Behavior Tracking 46 Commenting System 5 Device Fingerprinting 4 Show more tags...

Select all Select none Expand all Collapse all

Advertising 1000 trackers: blocking all

Analytics 344 trackers: blocking all

Beacons 417 ing all
Privacy 19 trackers: blocking none
Widgets 300 trackers: blocking none

Back Next

10. When complete, click the Next button, and then close the Ghostery page.

11. To test Ghostery, visit https://slashdot.com. Note the purple alerts that appear
in the bottom right corner, and the new Ghostery icon in the toolbar.

12. Click the Ghostery icon in the toolbar to learn more about Ghostery, and to
configure preferences.

From now on when visiting sites, you can see who is tracking you, and choose to
allow or block this from happening.
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14.8.5 Assignment: Install Ghostery for Chrome

In this assignment, you install the Ghostery extension for Chrome, monitor who
is monitoring you, and then block them.

1. Open Chrome.
2. Go to https://chrome.google.com.

3. Click Customize link at the top center of the window.

G chrome Features Customize Enterprise

4. Inthe Search the Store field, enter Ghostery, and then tap the Enter or Return
key. Extensions matching this search term will appear.

~ chrome web store marc@mintzit.com v | %
Ghostery X
«Home
Ghostery - Privacy Ad Blocker + ADDTO CHROME
ffered by www.ghostery. o
Extensions g ofterec by ghostery.com Productivity
Cleaner, faster, safer websites Ghostery is a powerful privacy extension. Block ads, stop Jek koK (12506)

Themes trackers and speed up websites.

5. When Ghostery is found, click ADD TO CHROME button.
6. Inthe Add “Ghostery”? dialog, click Add extension.

Add "Ghostery"? =

It can:
* Read and change all your data on the websites you visit

Cancel Add extension

7. Ghostery will display a few screens asking for your preferences. You may click
the One-Click Setup button to automatically configure, or click Custom Setup
to configure to your taste.
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KA GHOSTERY Seni

_° o @ Browse smarter with Ghostery!
“, s How would you like to begin?

(-]

L.
° % o ° -
. — .-
. i .
© .
+ © =4

One-Click Setup Custom Setup
Share my analytics and Choose my own settings by
Human Web data to answering a few short
improve Ghostery’s questions.
performance.
Learn more.

8. You may configure to your taste at this time, or do nothing. You can always
configure later.

9. Notice that you now have the Ghostery icon in the Chrome Tool bar. In this
example, it is notifying me that there are 3 trackers on the Ghostery page.

fa

10. Click the Ghostery icon. This will display information about who is tracking
you.
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) GHOSTERY Signin &

o

Blocked: 0

©

Trust Site

3

Trackers

www.microsoft.com

O

© Restrict Site

Page Load: 2.04 secs

Q

Il Pause v

11. Click the Detail View icon under the Sign in link to display more information.

12. Click on one of the trackers to see details on it. In this example, ClickTale.
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[S\ GHOSTERY signin i
TRACKERS & Block All
Collapse All
3 ° Advertising “
1 TRACKER
0 Adobe Audience Manager
204secs @ Site Analytics N
O 2 TRACKERS
: ClickTale

%)

ClickTale is a web usability tool that provides website analytics. The tool collects
information and reports on individual visitor behavior inside a web page. The

@ tool aggregates various visitor sess...
Continue to full tracker profile
Detected tracker URLs:
O https://cdnssl.clicktale.net/www32/ptc/755cc4ab-c4bf-46d8-a608-d3c5d66fabac.js
o SOASTA mPulse
I v —0
—o
-—0
List View

13. Hover your cursor to the right of one of the tracker names (in this example,
ClickTale), and you now have icons allowing you to Trust on this site, Block on
this site, and Block on all sites.
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A2\ GHOSTERY signin i

TRACKERS #* Block All
Collapse All

3 ° Advertising

1 TRACKER

0 Adobe Audience Manager

@ Ssite Analytics
2 TRACKERS

ClickTale OO0 X

ClickTale is a web usability tool that provides website analytics. The tool collects
information and reports on individual visitor behavior inside a web page. The
tool aggregates various visitor sess...

Continue to full tracker profile

Detected tracker URLs:

https://cdnssl.clicktale.net/www32/ptc/755cc4ab-c4bf-46d8-a608-d3c5d66fabac.js
SOASTA mPulse

] v —o0
—o
—o

List View

14. Click the 3-dot settings icon at the top right corner of the Ghostery window >
Settings. Explore the options, and then configure to your taste.

15. Close Chrome.

From now on when visiting sites, you can see who is tracking you, and choose to
allow or block this from happening.
14.8.6 Assignment: Install Ghostery for Firefox

In this assignment, you install the Ghostery extension for Firefox, monitor who is
monitoring you, and then block them.

p—

Open Firefox.

2. Click the menu icon (three horizontal lines) > Add-ons.
3. From the sidebar, select Extensions.
4

In the Search field, enter Ghostery.
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Select Ghostery-Privacy Add Blocker.
Click the Add to Firefox button.
At the Add Ghostery Privacy Ad Blocker? dialog box, click Add.

14 Web Browsing

Ghostery will display a few screens asking for your preferences. You may click

the One-Click Setup button to automatically configure, or click Custom Setup

to configure to your taste.

S8 GHoSTERY

(-]

o ox o
+ Om

One-Click Setup

Share my analytics and
Human Web data to
improve Ghostery’s
performance.

Learn more.

'° o @ Browse smarter with Ghostery!
“, s How would you like to begin?

Custom Setup

Choose my own settings by
answering a few short

questions.

9. You may configure to your taste at this time, or do nothing. You can always

configure later.

10. Notice that you now have the Ghostery icon in the Chrome Tool bar. In this
example, it is notifying me that there are 3 trackers on the Ghostery page.
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11. Click the Ghostery icon. This will display information about who is tracking

you.
) GHoSTERY Signin &

3

Trackers

ww.microsoft.com

Blocked: 0 Page Load: 2.04 secs
© @ 9

QO TrustSite © Restrict Site Il Pause v

12. Click the Detail View icon under the Sign in link to display more information.

13. Click on one of the trackers to see details on it. In this example, ClickTale.
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[S\ GHOSTERY signin i
TRACKERS & Block All
Collapse All
3 ° Advertising “
1 TRACKER
0 Adobe Audience Manager
204secs @ Site Analytics N
O 2 TRACKERS
: ClickTale

%)

ClickTale is a web usability tool that provides website analytics. The tool collects
information and reports on individual visitor behavior inside a web page. The

@ tool aggregates various visitor sess...
Continue to full tracker profile
Detected tracker URLs:
O https://cdnssl.clicktale.net/www32/ptc/755cc4ab-c4bf-46d8-a608-d3c5d66fabac.js
o SOASTA mPulse
I v —0
—o
-—0
List View

14. Hover your cursor to the right of one of the tracker names (in this example,
ClickTale), and you now have icons allowing you to Trust on this site, Block on
this site, and Block on all sites.
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A2\ GHOSTERY Signin £
g
TRACKERS Block Al
Collapse All
3 ° Advertising R
1 TRACKER
0 Adobe Audience Manager
204secs @ site Analytics R
2 TRACKERS
ClickTale o0 X

ClickTale is a web usability tool that provides website analytics. The tool collects
information and reports on individual visitor behavior inside a web page. The
tool aggregates various visitor sess...

Continue to full tracker profile

Detected tracker URLs:
https://cdnssl.clicktale.net/www32/ptc/755cc4ab-c4bf-46d8-a608-d3c5d66fabac.js

@ 0 -89

SOASTA mPulse

1] v —0
—0
-—0

List View

15. Click the 3-dot settings icon at the top right corner of the Ghostery window >
Settings. Explore the options, and then configure to your taste.

16. Close Firefox.

From now on when visiting sites, you can see who is tracking you, and choose to
allow or block this from happening.
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17. At the Tracker Options page, select the trackers to be blocked.

=\ GHOSTERY

Browser Extension Settings

General Blocking Options Trusted Sites Restricted Sites About Help
—

Tracker Options

Select the trackers that you want to block, individually or by category, to customize your browsing experience.

‘ Categories Collapse | Expar Show All Trackers ~ Unb!

Advertising
1675 TRACKERS

Provides advertising or advertising-related services such as data collection, behavioral analysis or retargeting.

Site Analytics
I-I-II-I 570 TRACKERS
Collects and analyzes data related to site usage and performance.

~ . Customer Interaction
N3 253 TRACKERS
Includes chat, email messaging, customer support, and other interaction tools.

a Social Media
95 TRACKERS

Integrates features related to social media sites.

Essential

58 TRACKERS
Includes tag managers, privacy notices, and technologies that are critical to the functionality of a website.

Audio/Video Player
55 TRACKERS

Enables websites to publish, distribute, and optimize video and audio content.

Adult Advertising

22 TRACKERS
Delivers advertising technology designed specifically for adult content sites

Comments
10 TRACKERS

Enables comments sections for articles and product reviews.

XXX

Clear track
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18. Select the General tab, and then configure to your taste.

=\ GHOSTERY

Browser Extension Settings

General Blocking Options Trusted Sites Restricted Sites About Help

Trackers

Enable automatic updates from the Ghostery tracker library
Auto-updates are highly recommended. Update now

. Show tracker URL patterns (7]

Highlight Interactive Trackers @
. Show me when | need to allow a tracker to use a site’s features

Replace blocked social media buttons with a Ghostery icon

Blocking

Trust and restrict individual trackers @

Allow trackers created by site owners
(For example, blocking a Facebook tracker on facebook.com might break the site. Turning this feature off might result in some pages breaking.)

[] Block new trackers added to Ghostery by default

Purple Box

. Show the purple box in the corner of my browser (2]

Dismiss After: 15 Seconds ~

Display In: Bottom Right Corner v

\:‘ Hide the purple box on trusted websites

Notifications

Notify me when Ghostery: (2]

Makes announcements

Releases new features

Releases minor defect fixes

Adds new trackers to its tracker library

Show page reload banner notifications at the top of the extension

Show tracker alert banner notifications at the top of the extension

[< < < I < < |

Show tracker count badge on the Ghostery icon in browser toolbar

Support Ghostery

Sharing page and tracker data
Ghostery is free because some of our users anonymously and voluntarily opt-in to share data with us about the sites and trackers the browser encounters.

. Sharing extension usage analytics
We collect usage analytics to better understand what features users like. For example , if you click pause, we will collect a ping letting us know you used th

Sharing Human Web data
Ghostery now implements the Human Web by default, a revolutionary technology that uses the wisdom of the crowd to build a more private internet

19. Close the Ghostery page.
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20. To test, visit https://slashdot.com.
21. Select the Ghostery icon in the toolbar. The Ghostery window will open,
displaying any trackers on this page, and if they were blocked.

y Slashdot: News for nerds, st. \+

180% | @  Q Search

18\ GHOSTERY

Trackers Block All :

1 Tracker

found on @ site Analytics
e 1 Tracker 1 Blocked

1 Blocked
1.60 Seconds

@ TrustSite
2017 @ Restrict Site
Pause Ghostery

Map These Trackers
‘WS
are a chunk

22. Close Firefox.
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14.9 Adobe Flash and Java

Both Adobe Flash and Oracle Java are used by many websites to create a more
animated or interactive web experience. Flash is no longer supported as a
standalone System Preference and should be removed. Its functions are now built
into the major web browsers, but will be removed when Adobe discontinues Flash
support in 2020. The functions of both will soon be absorbed by HTML 5.

The power these products offer is a double-edged sword. They can also be used to
take control of your computer. And often are. There is a vicious cat and mouse
game played by hackers who have discovered how to bend Flash and Java to their
wills, and Adobe and Oracle patching these vulnerabilities.

The result for users is they have a choice to make:
e Do not install Java, which renders some sites unusable.
e Install Java, and be vigilant with updates.

e Install Java, but don’t be vigilant with updates, rendering your system
vulnerable

I suspect if you are one who ops for the last option, you aren’t taking this course.

Either of the other two options are legitimate strategies. Oracle has tried to make
updates automatic, but we have found this process to be less than perfect. Many
times, we have found systems with out of date versions, even with their preference
settings on Automatic Updates.

Associated with the vulnerabilities caused by out of date Java, are malicious or
compromised web pages that prompt the visitor to update Flash, Java, or some
audio/video codec. In most cases, if you follow the links provided on the site all
that gets downloaded is malware.

If a site prompts you do install software, visit the website of the recommended
software and download from there, not from the requesting site.

14.9.1 Assignment: Configure Oracle Java for Automatic Updates

In this assignment, you install Java and configure it to automatically update.
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Install Oracle Java.

1. Open Apple menu > System Preferences. If you see the Java icon, it is already
installed. If so, skip to the next section Configure Java for Auto-Updates.

2. Open your browser to surf to http://www.java.com/.

Help

JAVA+YOU,
DOWNLOAD
TODAY!

Free Java Download

» What is Java? » Do | have Java? » Need Help? » Uninstall

3. Click the Free Java Download button.
4. Click the Agree and Start Free Download button.

5. Once the Java installer has downloaded, launch it, and then follow the on-
screen instructions to complete installation.

6. When installation completes, restart your computer.
Configure Java for Auto-Updates.

7. Select System Preferences > Java.
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8. Select the Update tab, and then enable the Check for Updates Automatically
checkbox.

o Java Control Panel
General W Java  Security  Advanced

Your system has the recommended version of Java.

Java 8 Update 51.

Check for Updates Automatically
Java Update was last run at 12:12 PM on 8/16/15.

L OK | Cancel Apply

At this point, both your Flash and Java are up to date, and configured to
automatically update. However, there is a decent chance that they will not do so. It
is wise to perform a manual update check at least monthly.

Manually check for Java updates

9. Open System Preferences > Java.
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10. Select the Update tab.

o Java Control Panel
General Java  Security  Advanced

Your system has the recommended version of Java.

Java 8 Update 101.

Check for Updates Automatically
Java Update was last run at 10:32 AM on 7/22/16.

ﬁ Cancel Apply

11. If updates are available, select the Update Now button, and then follow the on-
screen instructions to download and install.
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14.10Web Scams

Over the past couple of years, a new type of scam has become popular. Instead of
directly compromising the user computer, web sites are either compromised, or
are deliberately designed to be malicious.

When a user visits such a site, they may receive a pop-up window stating
something to the effect of: Your computer has been found to be infected with XX
viruses. Please call Apple at XXX-XXX-XXXX to have this infection removed.

Upon calling the provided toll-free phone number (which, of course, is not Apple,
but that of the scammer), with your permission, they will install remote control
software. After looking around your computer, they will assure they can remove
the malware for only $$$.

There are two problems here. First, they have installed remote control software
that allows the criminal access any time they wish. This gives them access to your
usernames, passwords, banking, and other information. The second is that they
now have your credit card information.

14.10.1 Recovering From A Web Scam

What to do if this happens to you?
In this assignment, you examine Safari for possible modifications.
1. Don’t call!

In most cases, the malicious website has modified your web browser preferences
to make the malicious page your home page.
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2. Open your browser preferences (in this example, Safari) > General. If the
Homepage field is not what you have set, delete the entry.

@® General

o ~ r I

1=/ ¢ Qa0 * B O
General Tabs AutoFill Passwords Search Security Privacy Notifications Extensions Advanced
Safari opens with: A new window

New windows open with: = Top Sites

New tabs open with: =~ Top Sites

Homepage:  http://

Efof o o

Remove history items: = After one year
Favorites shows: = [1] Favorites

Top Sites shows: 12 sites

File download location: = [&] Downloads

oo oo

Remove download list items: = After one day

Open “safe” files after downloading
“Safe" files include movies, pictures,
sounds, PDF and text documents, and
archives.

3. Malicious attacks on a browser often will block access to the browser
preferences. If you are not able to access your browser preferences to delete
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the homepage setting, open System Preferences > General, and then enable
Close windows when quitting an app.

®0 < i General | Q [search

Appearance: [l Blue B For Buttons, Menus, and Windows

| Use dark menu bar and Dock
| Automatically hide and show the menu bar

Highlight color: Blue B

Sidebar icon size:  Medium

Show scroll bars: (| Automatically based on mouse or trackpad
) When scrolling
© Always

Click in the scroll bar to: @ Jump to the next page
") Jump to the spot that's clicked

Default web browser: = @ Safari B

| Ask to keep changes when closing documents
Close windows when quitting an app

When selected, open documents and windows will not be restored
when you re-open an app.

Recent items: 10 B Documents, Apps, and Servers

Use LCD font smoothing when available ?

4. Quit Safari.

5. Open Safari to test. You should no longer have the malicious page open.

Done!
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14.11Tor

Tor'" is a technology developed by the US Department of the Navy that enables
anonymous web browsing. It has long since been released to the open source
community for the public to use in the form of the Tor Browser. Many people
within the security community are strong supporters of Tor, including Edward
Snowden. Entire books have been written on just Tor. I'm not so sadistic as to
subject you to that. What we are going to do is cut to the core of Tor, and learn
the basics of how to surf the web anonymously.

The advantages of Tor include:
e Strong anonymity for all activity on the Internet.

e Can be used with Tails!' which is a bootable, self-contained, flash drive that

can run on most Windows, Linux, and Apple computers that leaves no trace
behind.

e The bootable Tails flash drive can be immediately disconnected from the host
computer, causing the computer to erase memory of all trace of your session,
and reboot.

The disadvantages of Tor include:

e It was developed by the US Department of the Navy. It is possible there are
back doors only the government knows about.

e The US government has been forthright about having its own Tor relays in
place, which enable it to monitor online activity. Not a big deal if you only
wish to be anonymous to criminals. It is a big deal if you wish to be
anonymous while performing black-market deals for my Aunt Rose’s raisin
Noodle Koogle recipe.

These features make Tor ideal for those in oppressed countries, journalists
working undercover, and anyone who may need to use someone else’s computer
and leave no trace behind.

' http://en.wikipedia.org/wiki/Tor_(anonymity_network)
" https://tails.boum.org
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Tor works by encrypting your packets as they leave your computer, routing the
packets to a Tor relay computer hosted by thousands of volunteers on their own
systems, many of which are co-located at ISPs. The relay knows where the packet
came from, and the next relay the packet is handed to, but that is all. The user
computer automatically configures encrypted connections through the relays.
Packets will pass through several relays before being delivered to the intended
destination. Tor will use the same relays for around 10 minutes, and then different
relays will be randomly selected to create the next path for 10 minutes.

Alas, there is no free lunch. The encryption process and the relay process combine
to create latency, which mean a delay in processing. Most users will experience
around a four-fold performance degradation. So, if accessing a web page without
Tor normally takes 3 seconds, it may take 12 seconds with Tor.

Even though Tor does as good a job as anything to keep you anonymous on the
Internet, you must take precautions to protect your identity. These steps include:

e Don’t enable JavaScript when using Tor. This has been used to track users
within the Tor network.

e Don’t reveal your name or other personal information in web forms.

e Don’t customize the Tails boot flash drive. This will create a unique digital
fingerprint that can be used to identify you.

e Connect to sites that use HT'TPS so your communications are encrypted point
to point.

For many security-conscious users, Tor becomes their only tool for defense.
However, Tor by itself is at best a partial solution. It can protect your anonymity
while surfing the web. At the very least, this still leaves email and messaging to be
secured. A bigger issue is what to do when you need to use a computer and leave
no trace behind on that system. This is where Tails comes into play.

Tails is a Linux Debian fork designed with two primary purposes in mind:

e DProvide a highly secure operating system in a format that can be booted from
either DVD or thumb drive on almost any PC or Apple computer, and

e Include the tools and applications necessary to provide a secure, anonymous
Internet experience
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What this means is that you can create a thumb drive that has an operating system
capable of booting almost any computer, whereby you can then run Tor for secure
anonymous Internet activity, send and receive email that is securely encrypted
with GPG/PGP, and message with others in complete privacy. Then, when you
remove the Tails thumb drive, there is absolutely no record of your activity on
either the computer or the thumb drive!

For those of you chomping at the bit to just use Tor, we will start there. When
your curiosity has been satisfied, please take the next step to learn Tails".

14.11.1 Assignment: Install Tor For Anonymous Internet Browsing

Tor is a stripped down, simplified web browser, designed to provide an encrypted,
anonymous browsing experience.

In this assignment, you download and install Tor.

1. Asa first step, we need to know our public IP address. This information will
be used a few steps away to verify Tor has hidden our address. Open a web
browser to https://whatismyip.com. Write down Your IP.

WhatlsMyIP.com =

What Is My IP?

Your Public IPv4 is:
75.161.33.141

Your IPv6 is: Not Detected
Your Local IP is: 192.168.1.162
Location: Sunland Park, NM US @

ISP: Qwest Communications Company LLC

My IP Information What Is My Public IP? Proxy Check

"2 https://tails.boum.org
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2. Open a web browser and then go to https://www.torproject.org. Select the
Download Tor button.

Anonymity Online . m pevens peopi from

Home About Tor Documentation Press Blog Newsletter Contact
I (i

Download Volunteer Donate

We're hiring! »
learning your location or

Protect your privacy. Defend yourself browsing habits. ecent Blog Posts

against network surveillance and traffic

» Tor is for web browsers, [Explore Tor, NYC!] Tor for Jour...
analysis. instant messaging clients, Thu, 05 Apr 2018 Posted by: steph
27
¢ and/more: TorBirdy 0.2.4 is released
» Tor is free and open Mon, 02 Apr 2018 Posted by: sukhbir
Download Tor « source for Windows, Mac,
Linux/Unix, and Android Sunsetting Tor Messenger
Mon, 02 Apr 2018 Posted by: sukhbir

Tor 0.3.3.4-alpha Is released!

3. Select the Download Tor Browser button. The Tor installer will begin to
download.

4. While the download is in progress, scroll down the page to read all the other
steps that one must take to ensure your privacy is maintained. These include:

Use the Tor Browser. If you are concerned about protecting your privacy
and security, do not use other browsers.

Don’t torrent over Tor. If you wish to file-share via torrent, don’t use Tor.
It is painfully slow, it slows down others using the Tor network, and in
many cases, torrent software bypasses all the security and anonymity
precautions built into Tor.

Don’t enable or install browser plugins in Tor. Tor is designed to protect
your security and anonymity. Many innocuous-looking plugins break that
security.

Use HTTPS versions of websites. Tor has HI'TPS Everywhere built in
(more on HTTPS Everywhere later in this book.) It will force a secure
connection if a website has an option for https. This will enable a point-to-
point encryption between your computer and the web server.

Don’t open documents downloaded through Tor while online. Many
documents—particularly .doc, xIs, .ppt, and .pdf-contain links or resources
that will force a download when the document is opened. If they are
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opened while Tor is open, they will reveal your true IP address and you
will lose your anonymity and security. If you are concerned about these
issues, we strongly recommend that you instead:

e Open the documents on a computer fully disconnected from the
Internet. This prevents any malicious files from “phoning home” or
infecting your computer.

e Install a Virtual Machine (VM) such as Parallels, Fusion, or
VirtualBox, configured with no network connection, and open
documents within the VM. This is an alternate way to prevent
malicious files from phoning home or infecting your computer.

e Or use Tor while within Tails. This is an alternative way to prevent
malicious files from phoning home or infecting your computer.

e Use bridges and/or find company. Tor cannot prevent someone from
looking at your Internet traffic to discover you are using Tor. If this is a
concern for you, reduce the risk by configuring Tor to use a Tor Bridge
relay instead of a direct connection to the Tor network. Another option is
to have many other users running Tor on the same network. In this way,
your use of Tor is hidden.

Locate the Tor installer, and then double-click to open. It will mount and open
a disk image onto the Desktop.

Drag the TorBrowser.app into your Applications folder.

@® @ . Tor Browser

X 1 of 2 selected —_—

BROWSER

BUNDLE

Vo
Applications

Tor Browser » ; TorBrowser.app
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7. Locate the TorBrowser in your Applications folder, and then double-click to
open it. The Tor Network Settings window appears. Select how you would like
to connect to the Tor Network

o I would like to connect directly to the Tor network. This will work in most
situations. This option provides a faster Internet experience with no
additional configuration. The possible downside is that a network
administrator or your ISP can see that you are using the Tor Network.

o This computer’s Internet connection is censored or proxied. I need to
configure bridge or proxy settings. This option provides a more secure and
anonymous Internet experience as a network administrator or ISP is
unable to see you using the Tor Network. The downside is a slower
Internet experience, and some additional configuration.

Tor Network Settings

Before you connect to the Tor network, you need to provide
information about this computer's Internet connection.

BROWSER

Which of the following best describes your situation?

| would like to connect directly to the Tor network.
This will work in most situations.

Connect

This computer's Internet connection is censored or proxied.
| need to configure bridge or proxy settings.

Configure

For assistance, contact help@rt.torproject.org

Quit

8. Ifyou selected This computer’s Internet connection is censored or proxied. I
need to configure bridge or proxy settings, go to the next step. If you selected I
would like to connect directly to the Tor network, skip to step 14.

364



14 Web Browsing

9. Ifyou elected to use a Tor bridge relay, the following window appears. If your
network requires a proxy to access the Internet, go to the next step and select
Continue. Otherwise, select No, select the Continue button, and skip to step 12.

[ NoN ) Tor Network Settings

BROWSER

Does this computer need to use a proxy to access the Internet?

Yes
©ONo

If you are not sure how to answer this question, look at the Internet settings in another
browser to see whether it is configured to use a proxy.

For assistance, contact help@rt.torproject.org

Quit Go Back

10. If you selected Yes to Does this computer need to use a proxy to access the
Internet you will now see the Enter the Proxy settings window.

®0e Tor Network Settings
BROWSER
Enter the proxy settings.

Proxy Type: - B
Address: | IP address or hostname Port:

Username: Optional Password: Optional

For assistance, contact help@rt.torproject.org
Qi GoBack | (CERIGEN
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11. These will be the same settings your computer requires normally, and if used,
will be found in System Preferences > Network > Advanced > Proxies tab. Copy
your settings from this pane into the Tor window, and then select the
Continue button. If your ISP blocks or otherwise censor’s connections to the
Tor network, go to the next step to create a Tor bridge relay. If they do not,
skip to step 14 to start using Tor.

=" Wi-Fi

Wi-Fi  TCP/IP DNS WINS 802.1X Proxies Hardware

Select a protocol to configure: Secure Web Proxy Server

~| Auto Proxy Discovery
Automatic Proxy Configuration s
Proxy server requires password
Web Proxy (HTTP)
Username:
FTP Proxy
SOCKS Proxy
~| Streaming Proxy (RTSP)

Gopher Proxy

Password:

Exclude simple hostnames

Bypass proxy settings for these Hosts & Domains:
*.local, 169.254/16

v Use Passive FTP Mode (PASV)

? Cancel OK

12. At the Does your Internet Service Provider (ISP) block or otherwise censor
connections to the Tor Network window, for the overwhelming majority of
users the answer is No, and then select the Connect button, and then skip to
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step 14. If your answer is Yes, select the Yes option, select the Continue button,
and go to the next step.

[ NoN ) Tor Network Settings

oy 4

e |

BROWSER

Does your Internet Service Provider (ISP) block or otherwise censor connections to
the Tor Network?

Yes
ONo
If you are not sure how to answer this question, choose No. If you choose Yes, you will

be asked to configure Tor Bridges, which are unlisted relays that make it more difficult to
block connections to the Tor Network.

For assistance, contact help@rt.torproject.org

Quit GoBack | ([Connect)

13. If you selected Yes to the Does your ISP block or otherwise censor connections
to the Tor Network window, you now see the You may use the provided set of
bridges or you may obtain and enter a customer set of bridges window. Select

367



14 Web Browsing

Connect with provided bridges, Transport type obsf3 (recommended), and then
select the Connect button.

0 e Tor Network Settings

BROWSER

You may use the provided set of bridges or you may obtain and enter
a custom set of bridges.

© Connect with provided bridges
Transport type: obfs3 (recommended)
| Enter custom bridges ?

Enter one or more bridge relays (one per line).
type address:port

For assistance, contact help@rt.torproject.org
Quit Copy Tor Log To Clipboard GoBack | || Connect |
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14. The Tor Browser updates often. If your copy is out of date, you will be
welcomed by a message asking you to update. Follow the instructions, clicking
on the onion icon > Download Tor Browser Bundle Update...to update. Once
the download is complete, Quit Tor Browser, and then replace it with the new

14 Web Browsing

version. Otherwise, if you are up to date, skip to the next step.

000 /

About Tor % "'\+

S @v (€ 1-) U about:tor C | (B~ Startpage

New Idenmy
Cookie Protections
Preferences...
About Torbutton...

O;.Jen N.e-twork Settings... — Ilgratlllatlons '

w lﬁls Browser is configured to use Tor.

Tcst Tor \Ictwork Scmngs

HOWEVER, this browser is out of date.

Click on the onion and then choose Download Tor Browser Bundle Update.

|

Search securely with Startpage.

What Next? You Can Help!
Tor is NOT all you need to browse anonymously! There are many ways you can help make the Tor
You may need to change some of your browsing Network faster and stronger:

habits to ensure your identity stays safe. « Run a Tor Relay Node »

« Volunteer Your Services »

ips On Staying Anonymous » « Make a Donation »

The Tor Project is a US 501(c)(3) non-profit dedicated to the research, development, and
education of online anonymity and privacy. Learn more about The Tor Project »
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15. It is vital to test your connection to verify your IP address is hidden/changed.
While in Tor, go to https://check.torproject.org. You can also return to
https://whatismyip.com as well.

Congratulations. This browser is
configured to use Tor.

Your IP address appears to be: 185.165.168.229

(@) whatisMyiP.com

What Is My IP?

Your Public IPv4 is: Free WAN
185.165.168.229 Optimization
Boost WAN Speed &
Location: Victoria, 16 SC @ Save Costs. Free 2/ 20

Mbps Software License.

ISP: Flokinet Ltd - @

Questions & Answers My IP Information
What Is My Public IP? Proxy Check
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Wahoo! You are now on Tor, completely anonymous and encrypted on the
Internet. Next step is to configure Tor.

5.1.1 Assignment: Configure Tor Preferences

One of the first things one should do when launching an application for the first
time is to configure its preferences. No different for Tor.
In this assignment, you configure Tor preferences.

1. Open TorBrowser, and then select the 3 horizontal line menu (top right) >
Preferences > General tab. This pane may be configured to taste.

General General ®
Search
Content Startup
e Always check if Tor Browser is your default browser
Applications
Tor Browser is not your default browser Make Default

Privacy

When Tor Browser starts:| Show my home page v

Security

Sync Home Page: about:tor

Advanced Use Current Page Use Bookmark... Restore to Default

Downloads
Save files to Downloads Choose...

@® Always ask me where to save files

Tabs
v Open new windows in a new tab instead
v Don't load tabs until selected

v When | open a link in a new tab, switch to it immediately
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2. Select the Search tab.

General

Search

Content

Applications

Privacy

Security

Sync

Advanced

Search @

Default Search Engine
Choose your default search engine. Tor Browser uses it in the location bar, search bar, and
start page.

) DuckDuckGo v

Provide search suggestions

Show search suggestions in location bar results

Search suggestions will not be shown in location bar results because you have
configured Tor Browser to never remember history.

One-click search engines
The search bar lets you search alternate engines directly. Choose which ones to display.

Search Engine Keyword

D, Disconnect
D YouTube

G Google
Yahoo

() DuckDuckGo
8 Startpage

W Twitter

SR S S S S

w Wikipedia (en)

Restore Default Search Engines Remove

Add more search engines...

o For Default Search Engine, select DuckDuckGo.

e Other settings may be configured to your taste.

372




14 Web Browsing

3. Select the Content tab. Configure to your taste.

General

Search

Content

Applications

Privacy

Security

Sync

Advanced

Content

Notifications

Choose which sites are allowed to send you notifications ~ Learn more

Pop-ups
v | Block pop-up windows

Fonts & Colors

Default font:| Times v | Size: 16 v

Languages

Choose your preferred language for displaying pages

Choose...

Exceptions...

Advanced...

Colors...

Choose...
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4. Select the Applications tab. Configure to your taste.

General Applications

Search

Content Saaid

Applicati

ppRcaton: Content Type - Action

Privacy irc [Z] Always ask

Security ircs [Z] Always ask

Sync mailto [Z] Always ask
&y Podcast [Z] Preview in Tor Browser

Advanced
= Portable Document Format (PDF) [Z) Preview in Tor Browser
Video Podcast (] Preview in Tor Browser
Web Feed [Z] Preview in Tor Browser

webcal [Z] Always ask
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5. Select the Privacy tab.

General Privacy
Search
Content Tracking
Applications v/ | Use Tracking Protection in Private Windows  Learn more Change Block List
You can also manage your Do Not Track settings.
Privacy
v | Restrict third party cookies and other tracking data
Sacurity v/ | Change details that distinguish you from other Tor Browser users
Sync )
History
Advanced Tor Browser will:  Never remember history v

Tor Browser will use the same settings as private browsing, and will not remember any
history as you browse the Web.

You may also want to clear all current history.

Location Bar
When using the location bar, suggest:
v | History

v/ Bookmarks

v/ | Open tabs

Change preferences for search engine suggestions...

e Enable Tracking > Use Tracking Protection in Private Windows
e Enable History > Tor Browser will: > Never remember history

e Location Bar may be configured to your taste.
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6. Select the Security tab.

General SeCunty
Search
Content General
Applications v | Warn me when sites try to install add-ons Exceptions...
Privacy v | Block dangerous and deceptive content
v | Block dangerous downloads
Security
v/ | Warn me about unwanted and uncommon software
Sync
Logins
Advanced
Remember logins for sites Exceptions...
Use a master password Change Master Password...

Saved Logins...

e Enable General > Warn me when sites try to install add-ons.
e Enable General > Block reported attack sites.
e Enable General > Block reported web forgeries.

¢ Configure other settings to your taste.
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7. Select the Sync tab.

General

Search

Content

Applications

Privacy
Security
Sync

Advanced

General
Search

Content

Sync ®
Take your Web with you
Synchronize your bookmarks, history, tabs, passwords,
add-ons, and preferences across all your devices.
Connect with a Firefox Account
Create Sign
Account In
Sync to your mobile device. Download Firefox for Android or Firefox for iOS.
¢ Configure to your taste.
8. Select the Advanced tab, and then select the General tab.
Advanced
General Data Choices Network Update Certificates
Accessibility

Applications

Privacy

Security

Sync

Advanced

Always use the cursor keys to navigate within pages
Search for text when | start typing

Warn me when websites try to redirect or reload the page

Browsing
v Use autoscrolling
v | Use smooth scrolling
v | Use hardware acceleration when available

v | Check my spelling as | type

e Configure to your taste.
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9. Select the Data Choices tab, and then enable Enable Tor Browser Health

Report.

General
Search
Content
Applications
Privacy

Security

Sync

Advanced

14 Web Browsing

Advanced ®
General Data Choices Network Update Certificates
v Enable Tor Browser Health Report
Helps you understand your browser performance and shares data with Tor Project Learmn More

about your browser health
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10. Select the Network tab.

General Advanced ®
Search

General Data Choices Network Update Certificates
Content
Applications Connection
Privacy Configure how Tor Browser connects to the Internet Settings...
Security Cached Web Content
Sync Your web content cache is currently using 0 bytes of disk space Clear Now

Override automatic cache management

Advanced

Limit cacheto 350 MB of space

Offline Web Content and User Data

Your application cache is currently using 0 bytes of disk space Clear Now

v Tell me when a website asks to store data for offline use Exceptions...

The following websites are allowed to store data for offline use:

Remove...

e Enable Tell me when a website asks to store data for offline use.

¢ Configure other settings to your taste.
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11. Select the Update tab.

General
Search
Content
Applications
Privacy
Security

Sync

B, Advanced

Advanced

General Data Choices Network Update

Tor Browser updates:
@ Automatically install updates (recommended: improved security)
Check for updates, but let me choose whether to install them

Never check for updates (not recommended: security risk)

Show Update History

Automatically update:

v | Search Engines

Certificates

e Enable Automatically install updates (recommended: improved security).

e Enable Warn me if this will disable any of my add-ons.

e Enable Automatically update: Search Engines.

e Configure other settings to taste.
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12. Select the Certificates tab.

@ General Advanced ®
Q, Search
General Data Choices Network Update Certificates
& Content
A Applications Requests

o Privacy When a server requests my personal certificate:

Select one automatically

& Security

€) Sync

é’ Advanced

@ Ask me every time

v Query OCSP responder servers to confirm the current validity of certificates

View Certificates Security Devices

e Enable Requests > Ask me every time.

e Enable Query OCSP responder servers to confirm the current validity of
certificates.

13. Close the preferences tab in Tor.

Great work! You are now ready to use Tor to securely and anonymously browse
the Internet.

But remember, Tor is just one small part of real anonymity and security on the
Internet. Many in the Internet Security field (including Edward Snowden) believe
that to do this right, you will want a bootable Tails thumb drive. Learn all about it
in our upcoming Practical Paranoia: Tails Security Essentials book. In the
meantime, visit the Tails"> home page.

" https://tails.boum.org
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14.120nion Sites and the Deep Web

Tor not only allows you to have anonymous access to your regular web sites, it is
also the only gateway to the Deep web'”. The deep web is also known as the
Invisible Web. It consists of web content deliberately not indexed with standard
search engines, and only accessible by Tor. These sites are also called Onion sites,
as they end with .onion.

Although the deep web is primarily thought of as a collection of sites to sell illegal
products and services, there are also good and responsible uses for it. For example,
in repressive countries such sites provide an avenue for freedom workers to work,
for reporters to securely exchange information with sources (Ed Snowden did
this), and there are sites to provide resources for whistleblowers.

As the deep web is not indexed by Google, Bing, or any other standard search
engine, how do you go about discovering its resources? The list is in constant flux,
but as of this writing, here are some good starting points:

e TorLinks?
e Torch't

e Torch Tor Search?”

' https://en.wikipedia.org/wiki/Deep_web_(search)
5 http://torlinkbgs6aabns.onion

' http://xmh57jrzrnwé6insl.onion/

'7 http://torchtorsearch.com
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14.13Have | Been Pwned

“WHAT!?!” is probably the first thing that just went through your mind. No, it’s
not a typo. Pwn, as defined in the dictionary, is to be totally defeated or
dominated. Although most commonly used when trouncing your online game

opponent, it is also used to describe when your email or online accounts have
been hacked.

And there is a pretty good chance that you have been pwned!

There are several websites that track email and online account breaches. My
favorites are haveibeenpwned and hacked-emails.com.

In this assignment, you search the haveibeenpwned.com database to discover if
any of your online accounts have been hacked/pwned/breached.

14.13.1 Assignment: Has Your Email Been Hacked

In this assignment, you search the haveibeenpwned.com and hacked-emails.com
databases to discover if any of your online accounts have been hacked/pwned.

1. Open a web browser to https://haveibeenpwned.com. The home page appears.

Home Notifyme Domainsearch Who's been pwned Pastes APl About Donate B P

'"--have i been pwned?

Check if you have an account that has been compromised in a data breach

email address or username pwned?

2. Enter your email address, and then click the pwned? Button.
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3. Inafew seconds, the results will display.

steve@apple.com

Oh no — pwned!

Pwned on 14 breached sites and found 7 pastes (subscribe to search sensitive breaches)

=% Notify me when | get pwned B P Donate

Breaches you were pwned in

A "breach" is an incident where a site's data has been illegally accessed by hackers and then released publicly. Review the types of
data that were compromised (email addresses, passwords, credit cards etc.) and take appropriate action, such as changing
passwords.

000webhost: In approximately March 2015, the free web hosting provider 000webhost suffered a major data
breach that exposed over 13 million customer records. The data was sold and traded before 000webhost was
alerted in October. The breach included names, email addresses and plain text passwords.

Compromised data: Email addresses, IP addresses, Names, Passwords

Adobe: In October 2013, 153 million Adobe accounts were breached with each containing an internal ID,
username, email, encrypted password and a password hint in plain text. The password cryptography was
poorly done and many were quickly resolved back to plain text. The unencrypted hints also disclosed much
about the passwords adding further to the risk that hundreds of millions of Adobe customers already faced.

Compromised data: Email addresses, Password hints, Passwords, Usernames

Dropbox: In mid-2012, Dropbox suffered a data breach which exposed the stored credentials of tens of
millions of their customers. In August 2016, they forced password resets for customers they believed may be
at risk. A large volume of data totalling over 68 million records was subsequently traded online and included
email addresses and salted hashes of passwords (half of them SHA1, half of them bcrypt).

Compromised data: Email addresses, Passwords

Final Fantasy Shrine: In September 2015, the Final Fantasy discussion forum known as FFShrine was
breached and the data dumped publicly. Approximately 620k records were released containing email
addresses, IP addresses and salted hashes of passwords.

FFShrine

Compromised data: Email addresses, Passwords, Usernames, Website activity

4. Make a note of the sites with breaches.
5. Inyour browser, go to https://hacked-emails.com.

6. Enter your email address, and then click Check.
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7. All found breaches will display.

HOME VERIFIED LEAKS LATEST DATALEAKS APl ABOUT THE PROJECT

Has my email been hacked?

steve@apple.com

CHECK

We have found 46 entries for
steve@apple.com

We use the term Data Leak for when a site has been accessed through a vulnerability in its system and
information obtained is shared publicly. See the matches we have found and take the suitable measures,
such as changing your passwords or asking the site where the information was published to remove the

content.

Are you a Google Chrome user? Check our GMail extension!

- available in the
c chrome web store

Highlighted leaks where your email has been compromised

(" & dailymotion.com (ci edmodo.com

\__/ 87.164.388 Emails found Y/ 43.219.733 Emails found

8. Close your browser.
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14.13.2 Assignment: What To Do Now That You Have Been Breached

In this assignment, you take action to repair any found breaches.

1.
2.

Prerequisites: Completion of the previous assignment.
Open a web browser, and then go to the first breach site.
Change your account password, following best practices:

o Passphrase is a minimum of 15 characters, in an easy to remember, easy to
enter phrase.

o Use the password/passphrase for only one site. Should a site become
compromised and your password harvested, the automated hacking
systems will use your credentials at every bank, online store, etc. to see if
you are like most folks, using one password for everything.

o Keep a secure record of your passwords/passphrases. I personally like to
use LastPass as my password manager. Using a current version of Excel to
create an encrypted spreadsheet also works well.

o Only enter a username and password when in a secure web page (https).

Repeat steps 1 & 2 for each breached site.
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15 Email

15.1 The Killer App

It can be rightfully argued that email is the killer app that brought the Internet out
of the geek world of university and military usage and into our homes (that is, if
you can ignore the overwhelming impact of Internet pornography.) Most email
users live in some foggy surreal world with the belief they have a God or
constitutionally given right to privacy in their email communications.

No such right exists. Google, Yahoo!, Microsoft, Comcast, or whoever hosts your
email service all are very likely to turn over all records of your email whenever a
government agency asks for that data. In most cases, your email is sent and
received in clear text so that anyone along the dozens of routers and servers
between you and the other person can clearly read your messages. Add to this
knowledge the recent revelations about PRISM?, where the government doesn’t
have to ask your provider for records, the government simply has your records.

If you find this as distasteful as I do, then let’s put an end to it!

* https://en.wikipedia.org/wiki/PRISM_(surveillance_program)
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Toll-free: +1 888.479.0690 * Local: 505.814.1413
info@mintzIT.com ¢ https://mintzit.com
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This is an age of government intrusion into every aspect of our digital lives, criminals using your
own data against you, and teenagers competing to see who can crack your password the fastest.

Every organization, every computer user, everyone should be taking steps to protect and secure
their digital lives.
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